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IMPORTANT NOTICE

It is very important that adequate precautions are taken to ensure that data held within the
Direct Debit system is protected by network security procedures and policies. This is especially
important if other individuals have access to your PCs resources either directly (via physical
access) or indirectly (via a network connection). Please contact your network administrator if

you have any concerns in this area who may be able to impose Windows Domain type folder
access restrictions on the folders used by the Direct Debits system. These folders names can
be obtained by referencing the "Data Directory" and "Prog. Directory" entries when clicking
"Help/About" within the system.

1. Introducing Moorepay Direct Debit Solutions

This section gives an overview of Moorepay Direct Debit Solutions, explaining its features and options,
with particular reference to use of the Moorepay Direct Debit Solutions electronic system. A separate manual
covers using the service with paper forms.

1.1 Welcome to Moorepay Direct Debit Solutions

Moorepay Direct Debit Solutions is provided by Moorepay Direct Debit Solutions to collect and control Direct
Debit payments for you from your payers’ bank accounts.

Moorepay Direct Debit Solutions provides:

accurate and controlled collection of payments

a choice of input methods for payers’ details and payment instructions
detailed records of all your regular payers

comprehensive reports of all payment instructions

representation of unpaid Direct Debits.

The Direct Debit scheme provides an easy and efficient way of collecting through Bacs UK sterling payments
directly from payers’ bank accounts.

Bacs is an electronic funds transfer system enabling automated debits and credits to be transferred between
major UK clearing banks and building societies.

Moorepay Direct Debit Solutions can only be used by organisations that are already set up as
Bacs/BACSTEL-IP Service Users. This is a pre-requisite for all Moorepay Direct Debit Solutions users
and enables organisations to collect Bacs processing reports from the Bacs Payment Services website
(internet access required). The Bacs/BACSTEL-IP set up process includes a number of activities such
as your Sponsor Bank allocating a Bacs Service User Number and signing off various documentation
including the Direct Debit Instruction and Advance Notice.

It is imperative that all Direct Debit Service Users collect their operational Bacs Reports from the Bacs
Payment Services Website. Guidance about collecting your Bacs Reports and how to access the Bacs
Payment Services Website will have been provided by your Sponsor Bank.

As a Bacs/BACSTEL-IP registered contact, certain information is registered on the Payment Services web
channel about you. This information is used in relation to your use of the Bacs/BACSTEL-IP and includes
contact information (e.g. email address, telephone and fax numbers), privileges (what you are entitled to do
within the service — e.g. retrieve reports) and security information (details of your security credentials: i.e.
Smart Card or Alternative Security Mechanism (ASM).
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As you submit via Moorepay Direct Debit Solutions, in most cases, you will be registered to use ASM.

You will have been provided with a User ID and Password for accessing the Bacs Payment Services website
reports when your Sponsor Bank set you up as a Bacs User and allocated you with a Service User Number.
You are required to maintain user controlled contact information by logging on to the Bacs Payment Service
Website. This will ensure that you receive prompt notification of reports and important communication
regarding the Bacs/BACSTEL-IP Service.

1.2 How Moorepay Direct Debit Solutions works

Moorepay Direct Debit Solutions maintains records of all your payers and initiates Direct Debits on your
behalf via Bacs, from the information and instructions you submit to Moorepay Direct Debit Solutions.

Preparing to use Moorepay Direct Debit Solutions

During the initial application process, we put details about your organisation into the Moorepay Direct Debit
Solutions database. We give you a unique customer number to identify all Direct Debit transactions on
your behalf.

You will record details of each payer on a Payer Details screen. For each new payer you must provide a
unique payer reference, in a format which is acceptable to Moorepay Direct Debit Solutions. We use the
payer reference to process and collect your Direct Debit payments via Bacs.

Creating payment instructions

Moorepay Direct Debit Solutions allows you to collect fixed or variable payment amounts, or both. You can
create payment instructions to collect payments at regular or irregular intervals and for specific or varying
periods of time.

Moorepay Direct Debit Solutions screens are available for you to create fixed payment programs and
variable payment instructions.

The maximum individual payment amount you can collect is £500,000. If you collect payments in excess of
£500,000 please contact the Moorepay Direct Debit Solutions Help Desk to discuss your requirements

If you use the VAT at current rate facility (VAT code 1) payments will always be grossed up at the VAT rate
which applies three working days before the payment date. You will need to ensure that you factor this in to
your payment collection dates when there are changes to VAT rates. Please contact the Moorepay Direct
Debit Solutions Help Desk if you wish to discuss your requirements.

Submitting your payment instructions
Your prepared payment instructions are sent electronically to Moorepay Direct Debit Solutions and sorted
into batches for each type of instruction. Sending your instructions promptly to Moorepay Direct Debit

Solutions ensures that payments are collected on time. In general, you should ensure that your new payment
instructions reach Moorepay Direct Debit Solutions at least four working days before the due payment date.

Processing your payment instructions

moorepay

Electronic Service User Manual ;
Payroll & HR Solutions



Moorepay Direct Debit Solutions enters your batches of Direct Debit instructions into its database and sends
them electronically to Bacs for processing. Bacs uses your instructions to transfer debits and the subsequent
credit automatically between your payers’ accounts and your account.

Payments are executed on the payment date.

The Moorepay Direct Debit Solutions Bureau will input the file into the Bacs System. Files input on a Monday
will be processed on a Tuesday with payments being collected from Payer bank accounts on a Wednesday.

Cancelling Payments and Extracting Payment files

Cancelling payments — any payment cancellations must be notified to Moorepay Direct Debit Solutions no
later than 12 noon, three working days before payment is due.

Extracting Payment files — erroneous payment files already input to the Bacs System by Moorepay Direct
Debit Solutions can be extracted from the Bacs System two working days before payment is due.

Please contact *Bacs Operations for assistance should you wish to extract a Moorepay Direct Debit
Solutions payments file that has already been Input to the Bacs System by Moorepay Direct Debit Solutions.

It is not possible to extract payment files from the Bacs System if an error is discovered less than two
working days from the due payment date. In such circumstances, please contact
*Bacs Operations for advice.

*Note for contact number see 1.4 Support for Moorepay Direct Debit Solutions.

Receiving and using payment reports

You can obtain payment reports in electronic format from Moorepay Direct Debit Solutions.

You can use these reports to check and monitor your Direct Debit payment instructions.

You can also use the information in your separate Bacs reports to advise Moorepay Direct Debit
Solutions of any changes to payer details or payment instructions, to avoid payments being collected
from the wrong accounts.

1.3 Details about your organisation

When we prepared your files for Moorepay Direct Debit Solutions we recorded some details about
your organisation. A brief explanation of the main details and how we use them can be found in
Appendix A. If you need to change anything, please contact our Help Desk (see 1.4 below),
quoting your Customer Number.
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1.4 Support for Moorepay Direct Debit Solutions

In addition to this user guide, you can access help on-screen. Moorepay Direct Debit Solutions customers
are also supported by two Help Desks which you may call if you experience a problem. The Help Desks are
available from Monday to Friday between 09:00 and 17:00.

Contact Telephone Fax Number Email Address For Example
Direct Debit 0870 850 2578 0845 647 2106 | bury.dd@moorpeay.co.uk | e« General enquiries
Solutions

e Copies of Direct
Debit Solutions
reports

¢ File/s technical
queries

e Deleting the
facility

*Or your Sponsoring Bank’s Bacs Operations area if you do not bank with us.

You may also contact Moorepay Direct Debit Solutions by post, as follows:

Direct Debit Solutions
Moorepay Ltd
Warwick House
Hollins Brook Way
Pilsworth

Lancashire

BL9 8RR
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2. Preparing to use Moorepay Direct Debit Solutions
on your PC

Before you start to use Moorepay Direct Debit Solutions on your PC, please familiarise yourself with
Appendix B that contains examples of the common menus and buttons that you will find on the Moorepay
Direct Debit Solutions screen.

2.1 Installing Moorepay Direct Debit Solutions

Insert the CD into your PC’s compact disc drive and follow the installation instructions in the ‘PC Direct
Debits System Setup’ window that appears on screen. If no ‘pop-up’ instructions appear on your screen open
the folder or window containing your CD drive and select ‘Setup.exe’.

[ra———— S -

i ol el B [t [t g o e g
o o it S

B s o |

The installation will give you the opportunity to select:

e whether the system is to be available on a standalone PC or connected network
e where on your PC you wish the system to be installed.

ot ol Bk s et | e

Pt e ey T e L

TN = = ST
At conclusion it will ask whether you wish the Moorepay Direct Debit Solutions icon to be available

on your PC desktop — this will enable you in future to open the application quickly by double-clicking
the desktop icon.
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2.2 Accessing Moorepay Direct Debit Solutions for the first time

2.2.1 Introduction

Double click your Moorepay Direct Debit Solutions desktop icon or click Start, point to Programs,
point to DD Solutions then click DD Solutions System. The mouse pointer will become an hourglass;
the application will be loaded in a few seconds.

The system will detect that this is a brand new installation and a special user notice will be displayed,
indicating procedures that should be followed when setting up the system. These procedures are highlighted
in the following user notice screen displayed upon entry to the system for the first time:

This notice screen will be displayed every time Moorepay
Direct Debit Solutions is accessed until the ‘Don’t show
me this message again’ box is checked.

It is recommended that before undertaking any of the I o © ST e
procedures below you print the notice (click the ‘Print’ o
button) or refer to ‘Appendix C — New Installation

Notice’ in this guide for a full version of the same notice.

2.2.2 Accessing the system

On closing the ‘New Installation Notice’ you will see a Login screen. This screen controls access to the
system. The cursor will be blinking at the User ID entry field.

1. AUser ID and Password are provided in your welcome letter (and
also in the ‘New Installation Notice’) to allow you initial access to Lser 1D I'_‘Dugnup

the system.
Pasvword [T

2. Enter the User ID and Password in the relevant boxes (note — they
are case sensitive).

e If the entered User ID and Password are valid, the Moorepay Direct Debit Solutions System is accessed.
e Before proceeding any further, the system will ask you to set up users and supervisors.

Vo bt eriteved the uystem wath Bhe DD Setup 1D Yiow must now setup offer usen

! wehary e L pee Mardenance™ screen that wil hen be sble o sccet: the sysem A1
least ore of thete uters should have “Supervsor™ scceis. Detals on how 1o do the
can be lound n the user gude

e You need to set up users before any data can be keyed or transmitted to the Moorepay Direct Debit
Solutions bureau — click OK to return to the main screen menu.

e From the main screen menu select ‘Tools >User Maintenance’ to start setting up users.
Full procedures are described in Section 3 below.
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2.2.3 Keying and changing passwords

This section contains information about using passwords to access the Moorepay Direct Debit Solutions
System. It is relevant for any user.

1. On opening the system you will be asked to key in your User ID and User ID |
password. Initially your supervisor will tell you what these are. You
should memorise your password and not divulge it to anyone. Password |

! Watring yous pasveced wall espee in S daya
Do pou wart o 1esst it now 7

2. When your password is due to expire you will receive an
invitation to choose a new one — click ‘Yes’ to enter a new _— No |
dialogue box and select your new password.

New Password Entry

HﬂPunmdl
Hewhw|

3. Enter your chosen password twice and click ‘Save’ Please refer to the
Password section in 3.1.1. for more details on password acceptability.
If your password does not meet these requirements an Error box will
appear inviting you to key another password.

o Save

% Cancel

. = Password '
4. The system’s acceptance of your new password will be J) S
indicated by an on-screen message. Please now login using this new password

Click ‘OK’ to log in using your new password by keying into
the box shown in 1 above.

Important note:

If you do not change your password before it expires, you will need to request a supervisor to set you up
again as a system user.

moorepay
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3. The role of the Supervisor (1) Administering users

When you installed the Moorepay Direct Debit Solutions CD (Section 2) you used a default User ID and
password already installed on the system. These default settings allowed you initial access to the system in
order to set up users.

The Moorepay Direct Debit Solutions System contains sensitive and confidential data. To ensure appropriate
access to and use of the data, Moorepay Direct Debit Solutions allows the setting up of User Login IDs and
passwords to control access at varying levels.

You can set up users with different user privileges, or ‘Access Rights’, which govern the level of authority
each user has within the Moorepay Direct Debit Solutions System.

3.1 Different types of users

The different types of user privilege are described below:

Supervisor Enables the user to access ‘User Maintenance’, ‘System Setup’
and ‘Test Transmission’ options.

Input Enables a user to key new data and make changes to existing data.

Transmit Enables a user to transmit data to the processing bureau and pick up files and
reports from the bureau.

Import Enables a user to import new customer numbers from Moorepay Direct Debit
Solutions into the system; however, a user first requires ‘transmit’ permission to
pick up the file from the Moorepay Direct Debit Solutions bureau.

Enquiry Enables a user to view reports and enquire on both existing and cancelled
payer detalils.

3.2 The importance of setting up a supervisor

It is important that you set up a user with ‘supervisor’ access upon first entry to the system. You may
appoint more than one supervisor — this is recommended to cover times when one Supervisor may
be unavailable.

Once a user with ‘supervisor’ access has been set up the initial user settings (i.e. the initial User ID and
password) will automatically be deleted by the system.

You can set up a supervisor by using the ‘User Maintenance’ screen. After first entry to the system only
users with ‘supervisor’ access are able to access this screen.

You can use the ‘User Maintenance’ screen whenever you wish to add new users, cancel users or change
users’ privileges.

moorepay
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3.3 Accessing the User Maintenance screen

Select Tools >User Maintenance from the menu bar. The screen below will be displayed. You will
complete this screen for each new user.

s|nj ¢ 1 Wl [l ] 4 £t Y
el N 0 S B

| b g e g

L il # [FJra——

(T — Foune e F e

T

Frag e I

e r—

il -

Button changes to
LE ]

‘close’ once changes are saved
O [ARTIT /

This section first tells you about the different fields on the screen, how to move around the screen and how
to save the information you key.

The navigator-style buttons along the top of the screen allow you to review
- x = - users once you have set them up in the system. The buttons correspond to
S —— " (from left to right): First user, previous user, next user and last user.

* The ‘+' button allows a new user to be set up by entering information in the fields described below.
The -’ button deletes the selected user from the system. The system will ask you to confirm
- deletion before executing your instruction.

The following paragraphs tell you how to complete each area of the screen. After completing your

changes, remember to save the details by clicking the ‘Save’ button at the top left (or bottom right)
of the screen. The three ‘Changes’ option buttons at the top of the screen are explained below:

Duwect Debit Soluhions

Save current changes Cancel current changes

\Ell I ® | / and close the screen

Save current changes and
close the screen

Once you have saved your changes the ‘Save’ button at the bottom right of the screen will change to a
‘Close’ button.
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3.3.1 User Details

To set up users, complete the details for each user, starting with the supervisor or supervisors (see
3.1 above for a description of the different types of users). You must set up each user individually and
complete the fields on the User Maintenance screen. These are described in detail below.

User ID

This is the name with which the user will log into the system. It must be between four and eight characters in
length and may be alpha or alphanumeric.

User Full Name

This is the full name, or narrative, of the user.

Password

This is the password associated with the User ID. The user will need to enter this along with their User ID to
log into the system. When setting up new users the supervisor will need to allocate to each user an initial
password by keying it into this field. The system will ask for the password to be re-entered as confirmation.
The following validity checks will be performed on the password:

e The password must be between 8 and 12 characters in length
e The password must not be the same as any of the last 12 passwords used

e The password must include at least three of the following; mixed case, alpha, numerals and
special characters,

e The password must be changed at least once every 90 days

Important note:
To avoid unauthorised use of the system, users must keep their passwords confidential.

3.3.2 Password Information

It is recommended that users change their passwords from time to time to help prevent unauthorised
access to the system. The system has a default setting for password expiry of every 25 days, but you may
select another period, if preferred, by selecting from the options in the ‘Password Change’ box.

Password Change

On initial set up, this relates to the number of days to elapse before the password expires. Select your
preferred number of days by clicking the relevant button. The ‘Password Expires’ box indicates the
actual date of expiry. The user will be warned when their password is due to expire when they log in and
they will be given the opportunity to choose a new password at this point (see section 2.2.3 for details).

A users password can be changed at any time by selecting the appropriate menu option.

Last Changed

This is the date and time of the last change made to any details displayed on screen.
This is a display only field.
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3.3.3 User Access Rights

As well as controlling which users have access to the Moorepay Direct Debit Solutions System, it may be
necessary to control access to certain functions within the Moorepay Direct Debit Solutions System.

The Access Rights explained below were also explained in section 3.1. They govern the level of authority
each user has within the Moorepay Direct Debit Solutions System. Options not available to a user will be
disabled throughout the system, preventing unauthorised access. Select the desired privileges by

checking one or more of the boxes alongside the functions listed on screen and explained below.

Supervisor Enables a user to access ‘User Maintenance’, ‘System Setup’ and ‘Test
Transmission’ options.

Input Enables a user to key new data and make changes to existing data.

Transmit Enables a user to transmit data to the processing bureau and pick up files and
reports from the bureau.

Import Enables a user to import new customer numbers from Moorepay Direct Debit
Solutions into the system; however, a user first requires ‘transmit’ permission to
pick up the file from the Moorepay Direct Debit Solutions bureau.

Enquiry Enables a user to view reports and enquire on both existing and cancelled
payer details.

The screen below illustrates how a user has been set up as a supervisor.

Access Fughts

™ Supenisos
o ™ Input
P "
; L I T Transm

nproiay e I SE ™ impon

L s i ‘T\§

i Sy s *~§§ =

- - T =
PRI - - 57 1\ O

If no access rights are selected the user will only be able to read information in the system
(i.e. via the ‘Enquiry’ functions).

3.3.4 Other User Maintenance tools

Deny User Access

When checked (ticked), this will cause the user to be denied access to the system until the option is
unchecked. This option could be used, for example, if a user goes on holiday and access to their login

should be denied.
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Reset User Password

When checked (ticked), this will cause the user to be prompted for a new password immediately after first
logging in with the existing password. This could be used when setting up new users with a password that
has been allocated by the supervisor; in this case the initial password should be over-ridden with one

selected by the user.

Reminder: After setting up a new user or amending user details save the details by clicking
the ‘Save’ button.
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4 The role of the Supervisor (2) Administrating the system

4.1 Introduction.

The System Setup screen allows the user to configure various options within the system and can only be
accessed by a user with Supervisor privilege (please refer to 3.1. Different types of users” for more
information on this).

Select Tools / System Setup to display the screen below: -

Secure Details Transmission Details

IP Address WWw.mpde.co.uk SFTP ] Transmission password e

Transmission Method
Username
Via Floppy Disk
FEEEEEEEEREKEKE
Password Via Modem
- Via SFTP/HTTPS
Misc. Details
Floppy Drive Letter A Default Payer Sequence
= By Payer Ref. ~ By Surname
Validate Sort Code / Acc. Mo.
Disable user session when inactive for :0 s
(Zero indicates never disable)
@Save
4.2 The System Setup Form.
The screen is split into four main areas: -

Top Left This area allows the setup of the selected “Transmission Method” parameters
(Transmission setup (see below).

parameters)

Top Right This area allows the selection of the main method of transmission and the
(Transmission transmission password.

details)

Bottom Left This is where you can specify settings such as having the system validate a
(Misc. details) payer’s bank details.

Bottom Right This is where you can set the order in which payers are accessed and displayed
(Payer sequence) within the system.

These areas are described in more detail in the rest of this section. It is worth pointing out that you will only
be able to carry out a test transmission and subsequent data transmissions once all relevant transmission
related details (top left/right) have been configured.
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4.3 Transmission Details.

These details allow you to control the way in which you send data to/from the processing bureau.

Transmission Details

Transmission password Information you transmit to Moorepay Direct Debit Solutions bureau for
processing must be validated by a password, otherwise the transmission
will be rejected. We will provide you with this trans mission password to
cover

all customer numbers you setup within the PC system.

Transmission Method This set of options controls how you will transmit data to/from the
Moorepay Direct Debit Solutions bureau for processing;

Via SFTP/HTTPS — This option will allow you to configure the system for
transmission via SFTP or HTTPS. The “Secure Details” section will be
presented to allow you to set up the parameters required for this type of
access (please see “Secure Details” below).

NB. This should be the preferred method of transmission due to security
and speed considerations over dial-up.

4.4 Misc. Details.

Various none-transmission type details can be configured here.

Misc. Details

Validate Sort Code / Acc. No. | Check this box if you want the PC system to validate any bank sort
code / account number combinations that are entered into the PC system
(recommended).

Disable user session Enter in here the number of minutes’ system inactivity the system
should allow before it disables all user interaction. Any further interaction
will only be allowed after the user keys their valid current password.

It is recommended that this facility be used to help prevent unauthorized
use of the system. If this facility is not required, enter zero.

Default payer sequence This sets the order in which payers are accessed during navigation in the
system, either using payers’ surnames or the references you give them.
Check the box relating to your preferred order. This order may be
over-ridden during a session by selecting a different order in the “Payer
search box” screen.
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4.5 Secure details.

Secure Details

Enter details related to the remote DD processing bureau server and the account details set up on your
behalf to enable to communicate with that server.

Secure Details

IP Address www.mpdc.co.uk SFTP 1
Username
skckokokokkokkokokok
Password
IP Address The address you type in here will be dependant on the mode of

transmission you select in the drop-down to the right of this field: -
SFTP: www.mpdc.co.uk
HTTPS: https://www.mpdc.co.uk

Username Enter the username that has been previously configured and confirmed
by the DD helpdesk for your customer number on the remove SFTP/HTTPS
DD server.

Password Enter the password associated with the username described above.

When all appropriate details have been entered click the “Save” button to save the details.
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5. Carrying out a Test Transmission

5.1 Checking your settings

Set up your ‘Modem/Secure Details’ and ‘Transmission Details’ via the ‘System Setup’ screen as
described in section 4.

In summary, you should check that you have done the following:
For SFTP transmissions:

In the ‘Transmission Details’ section check:
1. the Transmission Method ‘Via SFTP/HTTPS ' is selected. In the ‘Secure Details’ section check:
1. the I.P. Address entered is www.mpdc.co.uk
2. you have an appropriate username and password (previously advised by DD technical support)
3. the ‘Logging’ option is set to off unless advised otherwise by the Moorepay Direct Debit Solutions
Help Desk.

NB. You will need to ensure port 22 has been opened up on your firewall to allow
SFTP transmissions.

For HTTPS transmissions:

In the ‘Transmission Details’ section check:
1. the Transmission Method ‘Via SFTP/HTTPS’ is selected. In the ‘Secure Details’ section check:
1. the I.P. Address entered is https://www.mpdc.co.uk
2. You have an appropriate username and password (previously advised by DD technical support)
3. the ‘Logging’ option is set to off unless advised otherwise by the Moorepay Direct Debit Solutions
Help Desk.

NB. You will need to ensure port 443 has been opened up on your firewall to allow
HTTPS transmissions.

5.2 Test Transmission
Please note:

e only users with ‘supervisor’ or ‘transmit’ privileges can carry out a test transmission
e no Direct Debit information will be transmitted to (or from) the Moorepay Direct Debit Solutions bureau
during a Test Transmission

e once a successful test has been carried out there is no need for further tests unless your modem details
change (i.e. a different modem is to be used for transmission).

1. Select ‘Test Transmission’ from ‘File’ menu

Fle lrpet Enquy Repott Took Heb
Tt Transmizson
T genpe arly cheable cument setton
Ept ChisE
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2. Click OK to proceed.

?) T st marvenes mon rece ied
Vionp sk akecdt B0 Cany ool 8 beat manemeson The shoukd
Foll bt et ey org & oo modiem o had nol charged

e e Laat e o Danamdtes] M owervss § o wah o
ol wath e tead chob 08

Ploase Nobe -
MO DATA WAL BE TRANSMITTED DURING THIS TRAMSMISSION

o] coe |

3. The system will then begin the test transmission:

e Upon successful completion of the Test, a ‘Successful Test Transmission’ message will be displayed;
click ‘OK’.

Note:

These instructions also appear in the ‘New Installation Notice'.
If you experience any difficulty or unexpected results:

e check you have selected the correct logging and transmit options as specified in the steps above.
If you still experience difficulty please contact the Moorepay Direct Debit Solutions Help Desk.
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6. Setting up payers and updating details

If you have followed the actions up to Section 5 you will by now have added users to the system and
established the System Setup parameters.

Your next step will be to set up payers within the Moorepay Direct Debit Solutions System.
Note:
If you have previously used Moorepay Direct Debit Solutions via paper forms you can download your existing

payer records to your PC by dialling up the Moorepay Direct Debit Solutions bureau — see section 6.1 below;
otherwise, go straight to section 6.2.

6.1 Initial update of Payer Records

From the ‘Tools’ menu select ‘Set up/Update Payers’

[ jrou [romy Bepons | [ock feb

Lrarmest charsges | Updain deisls ChisT
mlal @] FIEReees ol
11761 TESTORGIN oo P

Ugpere Bark et Chch Fies

When selected, you will be prompted to enter your Customer Number to set up or update. You will have
received your Customer Number when we set you up on the Moorepay Direct Debit Solutions System.

Plaase enter the customer numbes to setup o update.

(oK ] _comce |

e Entering this number and clicking ‘OK’ prompts the system to dial out to Moorepay Direct Debit Solutions to
download all payer details set up in the Bureau for this customer number.

e Once this process has taken place, you will be prompted to click ‘OK’ to import all of the details into the PC
system (you will see progress bars informing you of stages in this procedure).

e When the ‘Import successfully completed’ box appears on screen, click ‘OK’.

Note:

You will not need to repeat this step if you regularly dial up the Moorepay Direct Debit Solutions bureau,
as the copying of active payer records automatically occurs whenever you connect to the bureau.

If you do not submit or collect data for a long period we recommend that you repeat this step from time to
time. This ensures that both the PC and bureau records are harmonised.
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6.2 Setting up, amending and cancelling Payer Details

If you have been given ‘Input’ privileges (see section 3.1) you can add or change information relating to your
payers. You can do this on the ‘Payer Details’ screen which you select from the ‘Input’ menu:

Juecl Debit Solutions - Paper impont

The ‘Payer Details’ screen shows details about a single payer. Here you can set up, amend and cancel
information about that particular payer.

View a list of available Move between different Payer Click this to set up new payer
payers by clicking here Details screens using these buttons

Check this box to cancel the Payer records

- moorepay
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6.3 Basic Payer Details

The screen contains fields to record the payer’'s name, contact details and date of birth.
The other specific fields cover:

Sort Code and Payer’s bank account details should be recorded in the sort code and account
Account Number number fields. These are validated if you have selected the appropriate option on
the ‘System Setup’ screen (see section 4).

Category Category numbers are two-digit codes of your choice in the range from 01 to
99. You can use this field to identify different groups or types of payers, e.g. 01
for male, 02 for female, 03 for junior, 04 for retired. Insert here a two-digit code
of your choice. If you leave the field blank it will default to 01.

VAT Code When we set you up as a user of Moorepay Direct Debit Solutions we record a
default

rate of VAT for the payments you collect (see Appendix A). If you wish

to override this rate for individual payers you may enter a valid VAT code in the
‘VAT Code'’ field:

e ‘0’ = VAT not applicable
e ‘1’ = VAT at current standard rate
e ‘2" =VAT zero rated

If you leave this field blank, your default rate will apply.

If you key any other character an error message will appear:

o Irvvald pay VAT Code enbered
Muist b -
Space - Delalt
0-VAT not spplcable
1-VAT af standaed rale
2-VAT zero rated

(-

Cancel Payer When you check this field:

e the payer’s details are removed from the records held by the Moorepay Direct
Debit Solutions bureau

e cancelled payer details and payment history records are retained on your PC.
You will still be able to view the payer’s details on your PC via a Cancelled
Payer Details enquiry (see section 8.2).

Important note: as cancelled payer records are not retained by the Direct
Debit Solutions bureau, to avoid risk of loss we recommend that you regularly
print or copy any cancelled payer details you may require

for back-up purposes.
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7. Managing Payment Details

Within the ‘Payer Details’ screen described in section 6, the ‘Payment Type’ selection box enables you
to choose the type of payer by selecting one of three buttons. According to your selection, Moorepay Direct
Debit Solutions will display the appropriate payment program input fields for you to key.

Fixed Payments

Select this option where payment patterns are repetitive. The screen will display
the input fields for fixed payment programs (see 7.1 below).

Variable Payments

Select this option where there is no set payment pattern or where payment
amounts change. In this case the variable payment input fields will be shown
(see 7.4 below).

No Payments

Select this option where you wish to record payer details but where no sort code
or account number details are held, e.g. as part of a customer database.
Do not complete the Fixed Payment Detalils fields (see 7.7 below).

7.1 Setting up Fixed Payments

The ‘Payer Details’ screen below displays the fields to be completed to set up fixed payments:

I e [ B [
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Frosse Ty |
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In the ‘Payment Details’ section of the screen complete the following fields:

Frequency Select the single-letter code for the payment frequency you require. If you point
the mouse at the Frequency field a ‘hover box’ will display the available codes
(also displayed below)
W — Weekly F — Fortnightly L — Four-weekly
M — Monthly B — Bi-monthly Q — Quarterly
C — Four-monthly H — Half-yearly Y — Yearly
Page 24
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Start Date

Enter the date (DD/MM/YY) on which the first payment is to be collected.
Moorepay Direct Debit Solutions accepts all valid dates (including Saturdays,
Sundays and Bank Holidays), but does not accept invalid dates (for example 30
February) or dates in the past.

If the payment date falls on a Saturday, Sunday or Bank Holiday,
Moorepay Direct Debit Solutions automatically moves the collection date forward
to the next working day.

If you are setting up more than one payment program payment line, the start
date for the second payment line must be later than the completion date for
the first payment line.

Amount

Enter the payment amount to be collected (in sterling).

If you specified VAT Code ‘1’, or you are using this code as the default rate,
you must enter the payment amount net of VAT. The amount will be grossed
up automatically at the VAT rate which applies three working days before the
payment date.

If you need to apply conditions to the fixed payments, you can enter the number of payments or dormancy
period; for example, you may wish to:

If you need the last line of the payment program to continue indefinitely, leave the ‘Payments’
or ‘Dormancy’ fields as blank or zero. This is known as the open-ended program.

restrict the number of payments being made

create an automatic payment holiday (omit some payments from a payment program)
keep a payer’s record on file after collection of the final payment

delete a payer’s record after the last payment has been collected

Payments

Enter the number of consecutive payments to be made, in the range 001 to 999,
for each program payment line.

To stop the program after the last payment and automatically cancel a payer
record, do not complete the ‘Dormancy’ field on the last payment line.

The payer record will be cancelled automatically after the final payment, if the
‘Dormancy’ field is left blank.

Dormancy

If you wish to give a payer a payment holiday before the next series of payments,
or to keep a payer record on file after the final payment is collected, you must
complete the ‘Dormancy’ field.

Enter the dormancy period, in the range 001 to 999, for each program
payment line.

The number you enter in the ‘Dormancy’ field is multiplied by the frequency of
payments to calculate the length of the dormancy period. For example, if you
require a dormancy period of six weeks and the frequency is fortnightly (‘F’), enter
‘003’ in the ‘Dormancy’ field.

The dormancy period must not exceed 13 months. Contact Moorepay Direct
Debit Solutions for help if you wish to extend the dormancy period beyond 13
months.When the end of the dormancy period is reached, the next payment
program line will begin. When the last line of the payment program is completed,
the payer record will be cancelled automatically.
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Repeat Checking the ‘Repeat’ field allows you to repeat all payment programs listed in
the Fixed Payment details. When Moorepay Direct Debit Solutions completes
your last payment program line, it returns to the first payment line and continues
to process each line until you amend the payment instruction or cancel the payer
record.To use the repeat program facility, you must complete the ‘Payments’
and, if appropriate, the ‘Dormancy’ payment control fields.

Important Note:
The repeat program will not begin until after the last dormancy period specified in
the last payment program line.

The repeat program will begin immediately after the final payment if you have a
number of payments without a dormancy period.

The repeat program will repeat continuously until you amend the payment
instruction or cancel the payer record.

Clear Prog Clicking this button will delete the content of all the fixed payment
programme fields.

The last section on the ‘Payer Details’ screen, headed ‘Next Payment Details’, shows, for information
purposes, the date and amount of the next scheduled payment.

7.2 Payment History

e From the ‘Payer Details’ screen, clicking the ‘Payment History’ tab allows access to the record of
a payer’s past payments.
e The payments are displayed in date order (most recent first). An example is shown below.
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7.3 Setting up Multiple Fixed Payments

If you want to set up an identical fixed payment arrangement for many

Erauy Hepots Tooh - : ) ; .
s Jook existing payers, you can do this on the ‘Fixed Single Line Payments’

Dedsia .
= ;:wmpm CibeF screen which you select from the ‘Input’ menu:
117 Yonable Payments Chbei
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The ‘Fixed Single Line Payments’ screen is displayed. Section 7.3.1 below describes how you can start
to enter multiple fixed payments.
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7.3.1 Payment Date Selection

The data displayed on this screen will depend on the selection you make in the ‘Payment Date Selection’
section (on the right of the screen).

Select new fixed Clicking this button allows you to select a new fixed payment date for the
payment date ‘Start Date’ column.

Select existing fixed Clicking this button will display a list of previously selected dates from which
payment date you can choose.

Note:

By default the drop-down box displays the next available payment date. By clicking ‘OK’ you can start

keying fixed payment programs for this date or you can overwrite it with your choice of new or alternative
existing date.

After selection of the date the left side of the screen changes to offer a template in which payment details
can be added.

= ros lae o= [=n oo
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7.3.2 Adding/Deleting a Payment

To add a payment line simply arrow down to first available blank line or click the ‘+' button (displayed above
the ‘Start Date’ column). To delete a line already keyed, click the ‘-’ button.

Payer Reference

When in this screen the ‘Payer Selection’ box will display for selection only payers that are set up

2 To view the available payer references click the icon (left) to reveal the ‘Payer Selection’ box.
Ir; |
as ‘fixed’ (see example below).

[Pt WSO
/ - —— ¢
The Payer Selection window lists the payers with fixed f- -3
payment programmes. To find a payer either: H= e
e Kkey the payer reference or payer name here; or H e
e scroll down the list, click on your chosen ‘Payer reference’ and on ¥ s
‘OK’ to select. B g e
o i X Lo |
Start Date

When entering payments, the payment line date defaults to the date initially selected (7.3.1 above).
However, this may be over-ridden by keying a different date into the line payment date field. When

I

the payments are saved they will then appear under the appropriate payment date selected.
v By pressing space on the ‘Freq.’ Field a drop-down list (see left) of available payment frequencies
’ will be presented:
W — Weekly F — Fortnightly L — Four-weekly
M — Monthly B — Bi-monthly Q — Quarterly
C — Four-monthly H — Half-yearly Y — Yearly

Completing the ‘Amount’, ‘No.” & ‘Dorm.’ Fields

Complete these fields with the relevant payment amount, the number of consecutive payments to be made
and any dormancy period (if applicable). You follow exactly the same guidelines as for the ‘Amount’,
‘Payments’ and ‘Dormancy’ fields on the ‘Payer Details’ screen — please refer to Section 7.1.

Checking Payment Totals

Use the ‘Balance’ facility in the bottom right hand corner of the ‘Fixed Single Line Payments’ screen to
check that you have entered the correct payment amounts.

(W 1250
Actual 1250
|[ Bslance
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From your source documentation, add up the total of your payments and enter the total in the ‘Given’
field and click ‘Balance’. An information box will be displayed on screen indicating either:

a) Yyour ‘Given’ total balances with the ‘Actual’ total; or
b) there is a difference between the two totals (and the amount of the difference).

If you have a difference, review your payment amounts and click in the relevant ‘Amount’ fields to amend
as appropriate.

7.4 Setting up Variable Payments win 3] P T |
TR o S
__mi
N — .
1. If you have a payer who will only make an = EE

occasional payment or payments of irregular  — o w

amounts and intervals, you can enter payment e Owanl | weee ) .

details by selecting the ‘Variable Payments’ ——_ " r—r— e

button in the ‘Payment Details’ section s e | -

2. Two fields will be displayed for completion.

3. You can enter the payment date directly into the field (using format DD/MM/YYYY) or by clicking the
calendar icon on the right of the screen to display the calendar and selecting the date you require.

=nje] s wlefsfnlo T 3

4. The calendar will highlight today’s date and _....-,__-__..._..._.. == ’

the earliest possible payment date available - w—

for selection. o e - o
5. Confirm or cancel your date selection. o . . ua- g v (18 .
Do not forget to save all your entered data it e | 0
before exiting the screen by clicking the ‘Save’ EE . x|
button (top left of the screen).

7.5 Setting up Multiple Variable Payments

If you want to set up variable payments for many existing payers you can do this on the
‘Variable Payments’ screen which you select from the ‘Input’ menu:

twect Debit Solubon: - Paper smpori
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The ‘Variable Payments’ screen is displayed. Section 7.5.1 below describes how you can start to enter
multiple variable payments.

7.5.1 Payment Date Selection

The data displayed on this screen will depend on the selection you make in the ‘Payment Date Selection’
section (right of the screen):

Select new var. Clicking this button allows you to select a new variable payment date for the
payment date ‘Payment Date’ column.
Select existing var. Clicking this button will display a list of previously selected dates from which
payment date you can choose.

Note:

By default the drop-down box displays the next available payment date. By clicking OK you can start keying
variable payments for this date.

After selection of the date, the left side of the screen changes to offer a template in which payment details
can be added. In the screen below, one variable payment line has been completed.

| Ems Lo L
ma L [T [ atm——
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7.5.2 Adding/Deleting a Payment

To add a payment line simply arrow down to first available blank line or click the ‘+' button (displayed above
the ‘Payment Date’ column). To delete a line already keyed, click the ‘-" button.

Payment Reference

To view available payer references click the icon (left) to reveal the ‘Payer Selection’ box.
r; I The box will display only payers that are set up as ‘variable’ for selection when in this screen.

The Payer Selection window lists the payers with variable payment
programmes. To find a payer either:

e key the payer reference or name here; or

e scroll down the list, click on your chosen ‘Payer reference’
and on ‘OK’ to select.

Payment Date
When entering payments, the payment line date defaults to the date selected initially (explained above).

However, this may be over-ridden by keying a different date into the line payment date field. When the
payments are saved they will then appear under the appropriate payment date selected.

Checking Payment Totals

Use the ‘Balance’ facility in the bottom right-hand corner of the Variable Payments ‘Payer Selection’
screen to check that you have entered the correct payment amounts.

Cahvan 1250
Actual 250

(Cesses )

From your source documentation, add up the total of your payments and enter the total in the ‘Given’ field
and click ‘Balance’. An information box will be displayed on screen indicating either:

a) Yyour ‘Given’ total balances with the ‘Actual’ total; or
b) there is a difference between the two totals (and the amount of the difference).

If you have a difference, review your payment amounts and click in the relevant ‘Amount’ fields to amend
as appropriate.
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7.6 Representing Unpaid Direct Debits

Moorepay Direct Debit Solutions gives you the facility to represent within one calendar month of their original
date Direct Debits that have been returned unpaid. If any such payments are available they will be displayed
in the ‘Payer Details’ screen.

By ‘checking’ the box you can request representation

7.7 Setting up Customers or Members without Payments

This screen allows you to record details where no sort code or account information is held,
e.g. where you may wish to record customer or member addresses for contact purposes.

In this case, by selecting ‘No Payments’ the screen will conceal the individual payment lines.
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8. Making System Enquiries

You can view current and cancelled payer records via options under the ‘Enquiry’ menu:

Enquiy Reports Tools Help
Current Pager Detals  ClilvAReP
Cancelled Payer Details Clil+AR+C

8.1 Current Payer Details
Click this option to view details of current payers:

The ‘Payer Details’ screen is displayed:

View a list of available payers by Move between different Payer Details
clicking here screens using these buttons

e This is almost identical to the ‘Payer EJFJ“-:JM,_ — LIRIL s
Details’ screen displayed via the ‘Input’
menu (see section 6.2). Y e
Fosbmrirs & 1
e A key difference is that this screen is o prescets
‘read-only’ and no payer details can be e g
set up or amended via the ‘Enquiry’ menu. . o—
e This is the only way that users o i ——
with ‘Enquiry-only’ access can see pi- e e
Payer Details. :
Vi S = ] | J

8.2 Cancelled Payer Details
Click this option to view details of cancelled payers:
The ‘Cancelled Payer Details’ screen is displayed:

e This is almost identical to the ‘Payer Details’ screen displayed via the ‘Payer Details’ enquiry
(see section 8.1).

e This screen is ‘read-only’ and no details can be amended via the ‘Enquiry’ menu.

e The cancelled payer details and payment history records are only held on your PC —
they are not held at the Moorepay Direct Debit Solutions bureau.

e Werecommend that you regularly print or copy any cancelled payer details you may require
for back-up purposes.
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9. Reports from Moorepay Direct Debit Solutions

Four types of reports are available from Moorepay Direct Debit Solutions:

Payer Changes Reports changes processed by the Moorepay Direct Debit Solutions bureau
Report
Bacs Debits Reports latest Bacs transactions or payments between specified dates
Report
Input Exceptions Reports transactions that Moorepay Direct Debit Solutions reports as
Report exceptions,

e.g. where the quoted sort code is rejected as invalid
Current Changes Reports data keyed since the last successful input transmission to the
Report Moorepay Direct Debit Solutions bureau

The reports can be accessed via the ‘Reports’ menu

Aeports Jook Help
Bayes Changes Report  CirdeF1
Eace Debits Repont CulsF2
Irput Exceptions Report CidsF3

Cument Changes Report  CirleFd

9.1 Payer Changes Report

An example of a Payer Changes Report is shown below:

Payer Changes Repart Daled: ZTAOT0T 110542 Page 1

out Lesc  Mew Vaue Lid Yalus Inprutt Bty npJl Lrabs /| ime

FAVCRGT
Pay Ling 1 O EEGD 0000 10 2 COAA05A 58 243000 {0 qlas 2003 1Az
DAWSON BAVERME
Py Lives 1 Q) el rionon 10 2 O 2000 2000 4 0 e 2N 104725
JINES FAYERYWDID
Sy G &C0sa7 qlas 21419/03 00 3657
AT Nidober 1 EMEATE flas 21 oAt
Miama JOMCS 10NCS qlms S0 08
Foranzme FRCD qlan 2150710 08.36.5
Tiile: 1] ylas 2800703 L8887
vy o y ey 215003 0853857
Py Tipwe F ey 20T 085457
Pay Lina 1 W20 TR0 62 0 Co0n 2000 95000 < 0 fles A 0938 8T
RIVERE PAYERVOE
Var Hay WEMPLSAIEE Y 10 ias PAR LR B R
\iar Par 250152002 _C218.00 qlas 21419/03 10.06.25
SMITH BAYERC2
AN Fomber BEGEEN 12346070 qime SN 02 50106
Advress LT 12 DEWE CLOSE B3 FAZEL RIGE AVERLUE qias 203 AR
Pagt Code HE4S TUL qieE 2147403 08.3E
Catagory 01 o3 qlag 2141103 0B F1AR
Pay Lina 1 T 12220s Sl u VOO0 S2A00A0 0 0 ghas 2R 0R.EAE
Caromlation  Payor Sannclind qlios L1003 ST 14

End el Aepard
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1. Selecting ‘Payer Changes Report’ displays an
initial screen that allows you to select the date
and time of an input transmission you made to
the Moorepay Direct Debit Solutions bureau.

Reports arvakabie hom e
Follcwenrad b arames toe

[(DEMAT SRR
TR T 15 44 45

Paypes Listng Duchee
% By Paye: Redeeerce

During this transmission, the bureau will have " By Payei Name
processed any input transmitted and produced a
report based on this input.

2. If any input was rejected by the Moorepay Direct Ve |

Debit Solutions bureau during this transmission\
then the transmission date and time line will have
an asterisk (*) displayed next to it.
3. The Payer Listing Order allows the report to be printed in reference or name order.

4. Click here to view the selected report.

9.2 Bacs Debits Report

Selecting ‘Bacs Debit Reports’ provides access to a menu of reports covering Bacs transactions.

EomEE e -

L N

& it BT e o

B ]

The Bacs Debits Report can be printed based on a number of different criteria. These are:

Transaction Type Selection

e Latest downloaded Bacs transactions. Every time a transmission is made to the Direct Debits Solutions
bureau, a check is made to see if there is any debit payment history to pick up from the bureau. This is then
used to update payer payment history in the PC. This option will report on this latest payment history.

e Select Bacs dates. This allows a report to be made of payment history (for all payers on file) based on date
ranges. In the example above, a report will be produced on all direct debits taken between the dates of
17/05/2001 and 21/05/2001 inclusive. This results in the print below being produced.

Beran Pravamemstivrs Reymat Deled: 200108 184232 Poagrs: 1
Faymant Pate; 17ULL1 I Gort - Trps  Amour Vat
PAYEAFC| BRZADE 17 800357 12335573 F =00z £35IC.00
PAYLHTWL ULAALIL 00 WBlode b ! T S S
Tetaln fnr 17MSCT TATR.7E TARIC.N
Paymnni Bwie: FAMSE1 T Typa  Amoun | Vi
PAYLHLIT  MILMLE L1} L C]EUlL sl
PAYENMT Wil ACk F Malw 457500
PEYERMS  SKMTH F S50 fu B8 1]
FavERTWE WILICh 12346578 F E0a TASM.D0
Totals for 210501 20020 L3E0 CMEDS. 0
Grond Totols: EXTH.E £37612.00 Eopli7.5e

e Reprint last print. This simply reprints the last report selected.
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Payer Listing Order

As for the Payer Changes Report, any report can be in either reference or name order.

9.3 Input Exceptions Report

This option presents a screen that is very similar to the Payer Changes Report screen described above.
However, only Payer Changes Reports that have exceptions are offered in the list to the user. The format of
the report is otherwise identical to the Payer Changes Report.

9.4 Current Changes Report

The Current Changes Report details any input keyed into the system since the last time a successful input
transmission was made to the Moorepay Direct Debit Solutions bureau. Any input detailed on this report will
only be effective on the PC and will not affect any data held in the bureau until the next time an input
transmission is made. Once a successful transmission is made and the bureau records are updated, this
report is cleared.

This report allows a user to check input keyed before it is transmitted to the Moorepay Direct Debit Solutions
bureau for updating live files.

The format of the report is very similar to that of the Payer Changes Report.

Payer Changes Report Dated: 210703 11:06:42 Paga 1

Naw Valus ; Oid Valug Input By Ingut Date / Tima
Payline1 @ 23/01/2003 £100.00 10 2 Q31051898 £430.00 0 O piles 21/01/03 10,0712
DAWSON PAYERG42
Payline1 @ 23/01/2003 £130.00 10 2 0 01/01/2000 E50.00 4 O piles 210103 10.07.25
JONES PAYERWDS
Sorl Code BODSET ailes 21/01/03 09.36.57
AT Number 12345678 giles 21/401/03 09.36, 57
Name JOMNES JOMNES giles 210103 09.36.57
Forename FRED giles 21/01/03 09.36.57
Tine MR ailes 21/01/03 09.36.57
Category o glas 21/01/03 09,36 57
Pay Type F gias 21/01/03 09.36.57
PayLline 1 W 1402/2003 £50.00 52 0 0 01/01/2000 £50.00 4 O gikes 21/01/03 09.36.57
RIVERS PAYERVO3
Var Pay 2301/2003 £465.10 giles 21/01/03 10.06.18
Var Pa 23/01/2003 £218.00 ailes 21/01/03 10.06.25
SMITH PAYERDZ

BTGS4321 12345678 5 21/401/03 09.34.18
Address L1 12 DENE CLOSE 53 HAZEL RIGG AVENLE ailes 21/01/03 09.34,18
Post Code  NE45 TUL giles 21/01/03 09.34.18
Category m 08 giles 21/401/03 09.34.18
Payline 7 M 12022003 E150.78 0 0 ¥ 010172000 E2I00.00 0 0 giles 2140103 09.34.18
Cancafation Payer Cancelled oiles 21/01/M3 09.37.14

End of Fepari

moorepay

Electronic Service User Manual :
Payroll & HR Solutions



10. Transmitting and updating data.

The ‘Tools’ menu offers you options for transmitting and updating your payer data. To do any of these tasks
you will connect to the Moorepay Direct Debit Solutions bureau. On-screen windows and progress bars will
inform you of the status of your transmission or update.

NB. The instructions on this page relate to the procedures for dial-up transmission via a modem. Fig. 10b
illustrates the menu that will be displayed if SFTP/HTTPS transmission has been selected.

As you will see, if your method of

Jock Help Tools  Help o R

Traramd charges / Update detals CideT Send data ko Bureau For processing ChrlT lt'ransmlsslllon is SFTP/HTTPS then

Update detals orby Ll Request payer update ChrHE requeStS are sent to the
server for the relevant downloads.

Update Request full payer setup

ma“ *‘:‘;TW Flss = Request bark account check files update These can then be pleEd up via
the "File/Pick up files from Bureau"
Please allow 10-15-mins before
attempting pick-up.

Fig. 10a Dial-up tools menu Fig. 10b SFTP/HTTPS tools menu

10.1 Transmit Changes/Update Details

Selecting this option will transmit to the Moorepay Direct Debit Solutions bureau for processing any
outstanding input you have keyed into the system. This input consists of any input detailed in the Current
Changes Report. The Moorepay Direct Debit Solutions System will prompt you to confirm the changes that
you wish to transmit, highlighting any newly-keyed payment amounts._It is important that you carefully
check your input, especially any payment totals, before transmitting data. The Moorepay Direct Debit
Solutions system will ask you to confirm that you have checked the data and wish to proceed with the
transmission.

The Moorepay Direct Debit Solutions bureau will process your input and update the customer files with
the input transmitted.

e The input processed (or rejected) will be available for viewing under the Payer Changes Report
after the transmission.

e When you transmit changes to the Moorepay Direct Debit Solutions bureau, any payer payment history
information will be automatically picked up and the enquiry system updated on the PC accordingly.

10.2 Update Details only

This option will dial out to the Moorepay Direct Debit Solutions bureau and attempt to pick up any payer
payment history information. This will, in turn, update the payer enquiry system on the PC.

e The update is carried out automatically when you transmit changes to the bureau.

e However, if no input transmissions are made for a period of time you may need to use this option to update
the enquiry system with Bacs debit history information.

e The history information is accumulated in the Moorepay Direct Debit Solutions bureau until it is picked up by

a PC transmission. At this point it is cleared ready for new Bacs transaction history to be built up again.

Click ‘Yes’ in the confirmation box to proceed.

by The el et s e o o s P
_-r_)' B Ly . s b P e s A
[T ——

TR i

e = |
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10.3 Set up/Update Payers

This option enables you to set up or update a customer number on the PC. This will involve dialling up the
bureau to pick up from the ‘live’ bureau files all payers’ details and payment history relating to the selected
customer number.

e You may have used this option when initially setting up Moorepay Direct Debit Solutions on your PC
under section 6.1 above.

e If the Customer Number is already set up on the PC then all the active payers are cleared down on the
PC prior to the update.

e This ensures that both the PC and bureau files are kept in-line.

e Once the customer is set up on the PC there should be no need to carry out this process again as the PC
enquiry system will be kept updated through transmissions described in 10.1 and 10.2 above.

Note:

A valid transmission password must be set up (please refer to ‘Transmission Password’ in section 4.3)
before a valid transmission may be made.

I |
Please note: the Moorepay Direct Debit Solutions bureau will not update any T e rr——
cancelled payer details in the enquiry system during this process. e
O
1. Key in the customer number to be updated. Click ‘OK’ to commence
O |
the update process.
.i) e e )
2. You will receive on-screen confirmation when the update is complete. CE

10.4 Update Bank Account Check File

Section 4 described how to set the Moorepay Direct Debit Solutions system to validate sort code and
account number information via the Payer Details screen. Successful validation depends on accessing
system ‘look-up files’ that contain details on valid sort codes and modulus checks etc. If these are not kept
updated then validation checks may fail.

e This option dials up the Moorepay Direct Debit Solutions bureau and picks up the latest bank validation
information available. This is in turn used to update the validation check files on the PC.

e If you know a sort code is valid, for example, and it keeps being rejected, it may be because it relates to a
branch that has recently been introduced. In this case it may be worth using this option to update your PC
bank account check files from the bureau’s records.

e These files in the Moorepay Direct Debit Solutions bureau will be updated on a monthly basis. For this

reason, please do not carry out this update more than once a month and only if you are having the validation

problems mentioned above.

e This confirmation box appears when you select ‘Update Bank Account . 2
Check Files’. Click ‘Yes’ to proceed. 1) T ——
e pome s b Linm
o

10.5 Transmission Problems

If you have difficulty transmitting data, check your telephone line connection and modem settings (see
sections 4 and 5). If you are unable to resolve the problem, please contact the Moorepay Direct Debit
Solutions Help Desk to discuss other options for sending your data.
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11. Exiting Moorepay Direct Debit Solutions

You can exit the Moorepay Direct Debit Solutions system temporarily or by closing down via the ‘File’ menu:

Duect Debit Solutions

Fle lnput Enquey Reports Tools Help
TJest Transmission
Temporarly disable cunent session
Ext CileE

11.1 Temporarily disable current session
Use this option if the current session is to remain active but suspended for a length of time.

Access to any options within the system will be denied unless the current user’'s password is correctly input
in the field displayed below.

Srusmon deabied -

T T i P Dot iLahibed

by e iy Corir with T CuTerd BN P
it e e e KON DA Twoet Dk

_—
(Z5] _xems)
11.2 Exit

This exits and shuts down the Moorepay Direct Debit Solutions system.
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Appendix A — Your Details and Moorepay Direct Debit
Solutions

Customer Number

A unique number allocated by the Moorepay Direct Debit Solutions bureau to identify your organisation as a
customer of the Moorepay Direct Debit Solutions Service. You must quote your Customer Number on all
forms and correspondence sent to Moorepay Direct Debit Solutions. When you connect electronically to
Moorepay Direct Debit Solutions, the service recognises you by this number.

Bacs User Number

A unique number allocated by your bank and used to set up your organisation’s Bacs Computer records.
This number is also known as the Bacs Originator’s Identification Number/Service User Number and must be
printed or stamped on your Direct Debit Instruction Form if you send input to us in paper format.

Bank Branch Sort Code
The sort code number of your bank branch, where all payments collected on your behalf are sent.

Account Number
The account number at your bank branch to which all payments collected on your behalf are credited.

Short Name

An abbreviation of your organisation’s name. The abbreviation is shown on each payer’s bank statement to
help them identify the source of the debit. The short name must be a recognisable form of the name which
appears on your Direct Debit Instruction Form.

Your choice of short name is governed by the rules of the Direct Debiting Scheme and there may be hidden
implications if you need to change it later.

Name and Address
The name and address of the person in your organisation who will receive Moorepay Direct Debit Solutions
output reports and correspondence.

VAT code
The ‘VAT default rate’ best suited to the needs of your organisation. Available options are:

e ‘0’ = VAT not applicable.
e ‘1’'=VAT at current standard rate.
e ‘2'=VAT zero-rated.

Most customers choose ‘VAT not applicable’. Your choice is applied to all payments collected on your behalf.
You can override the default rate for individual payers, if necessary.

Important Note:
If you choose the ‘VAT at current standard rate’ option, payments are always grossed up at the VAT rate
which applies three working days before the payment date.

This facility is not suitable for organisations who specify a ‘Tax Point’ or who show the VAT amount on their
invoices.

Invoice address
The name and address of the person in your organisation who will receive quarterly charging invoices from
Moorepay Direct Debit Solutions.
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Appendix B — About the Moorepay Direct Debit
Solutions system

!J,l B.1 System Requirements

)
To use the Moorepay Direct Debit Solutions system your PC should comply with the following
minimum standards:

MS Windows XP and above

Pentium/AMD CPU

1GB RAM

5MB of available hard disk space plus approximately 3MB per 1,000 payers

VGA Monitor

Windows compatible Mouse

For SFTP transmissions; Access to the internet. Port 22 opened for outgoing and incoming access.
For HTTPS transmissions; Access to the internet. Port 443 opened for outgoing and incoming access.

Supported networks

e MS Windows
e Novell v4.01 and above
Please note: Peer-to-peer networks and Citrix systems are not supported.

B.2 Conventions

~—  B.2.1 Mouse compatibility
In keeping with the majority of Windows compatible applications, the Moorepay Direct Debit Solutions
System gives you the option to use the mouse to perform certain functions such as selecting options and
fields.

This guide refers to several mouse techniques you will use when operating the System.

Click Press and release the left mouse button once.
Double click Press and release the left mouse button twice in rapid succession.
Point To move the mouse until the mouse pointer on the screen points to the item of choice.

You may notice the shape of the mouse pointer changing as you perform certain functions. The usual shape
of the pointer is an arrow; however, there are several other shapes that you will see.

When you are performing a function, which is not immediate, such as loading, or opening a file, the pointer
will appear as an hourglass. This indicates that the system is performing a process and you must wait a few
seconds. Once the task is completed, the pointer will return to an arrow shape again.
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If you point the mouse over a field where text is expected, such as an input field, the pointer will be seen as a
beam or bar. The pointer appears as a cross with arrowheads when you are moving an object or screen.

-

8 B.2.2 Short-cut keys

If you prefer to keep your hands on the keyboard, rather than constantly moving between the keyboard and
the mouse, you can make use of the short-cut keys which have been included throughout the Moorepay
Direct Debit Solutions system. The short-cut keys perform the same functions as the menu options, such as
the underlined F for the File menu.

B.2.3 Moving around the Moorepay Direct Debit Solutions system
Moving around the screens is easy and can be done in a variety of ways:

clicking on menus and fields with the mouse
you can also use the TAB key, which will move you forwards, through the fields on a screen
SHIFT + TAB will move you backwards through the fields on a screen

using the TAB key avoids the need to keep moving between the mouse and the keyboard, and is often
the preferred method of getting around the screens

e to move around within fields, you can use the cursor keys.

Additionally, the system follows the Windows convention for short cuts. You can select any fields or menu
options which have underlined letters by holding down the ALT key and then pressing the underlined letter.

Menu options may also have a combination of keys (displayed to the right of the menu item) allowing direct

access to that option. For example, the ‘Ctrl+P’ displayed next to the ‘Payer Details’ menu item indicates that
pressing the <Ctrl> and ‘P’ keys at the same time will take you directly into the ‘Payer Details Screen’.

B.2.4 Messages and hints

The system benefits from standard messages to help you enter data and will detail any problems,
or in the case of invalid input, will give valid alternatives where possible.

The system also benefits from ‘hints’ which appear as you hover the mouse pointer over input fields

and buttons on the Toolbar. The hints indicate either the expected input for the field, or the function of the
toolbar button.

B.2.5 How data is displayed

Data in the Basic and Statutory Details screens is displayed in one of three colours:

Black Permanent Data
Blue New data, which has been keyed but not yet saved
Red New data, which has been keyed and saved but not yet transmitted

moorepay
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B.3 Moorepay Direct Debit Solutions system buttons

hepat Dlodad * slammens

o it Loy fopets Joks i

aln) o sif k| e|s|n]e T3
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The top part of the main Moorepay Direct Debit Solutions system screen is always visible to the user.
This allows the user various facilities that are available on all input screens etc. These ‘common’ options
are explained below.

B.3.1 Saving changes

Remember to save your completed changes before exiting a screen or the system. The buttons at the top
left of the screen provide you with different saving options:

Save Button — saves any data fie Input Enquy B Cancel Button — cancels any changes
displayed on screen. The user remains El QI ® the user has made.to the current screen
in the current screen. — ™~ i ~ and the user will exit the screen.

T

Save and Exit — saves any data
displayed on screen and the user will
exit the current screen.

B.3.2 Record navigator

The Record Navigator is an array of buttons that can be used to navigate between payers within the
Moorepay Direct Debit Solutions System on input/enquiry screens.

elelalnle)

First Payer Previous Payer Next Payer Last Payer Insert Payer

Note:

Insert Payer will automatically enter the ‘Payer Set-up’ screen, regardless of the screen currently accessed.
This enables quick and easy entry of new payer details.

B.3.3 Payer Search selection button

e This button displays a selection box to the user from which a payer can be selected for
input/enquiry purposes (depending on the screen currently displayed).

moorepay
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B.3.4 Customer Number selection box
By clicking the arrow (displayed on the right hand side of the box) your other Customer

|"?53 j" Numbers (if any) that have been set up in the Direct Debit system are displayed.
From this list another customer’s details may be accessed.

B.3.5 Menu access

The menu options allow access to all areas of the system. However, depending on your ‘Access Right’
(See ‘User Maintenance’), certain options may be disabled.

B.4 Data security and sensitivity
Data and Information

To respect the sensitivity and confidentiality of information and data stored and used in your system you
should ensure that:

e access is restricted to appropriate personnel
e the purpose and importance of User IDs and passwords are clearly understood.

All data you select for transmission to the processing bureau is encrypted both prior to and during
data transfer.
Data Protection Act

As a user of the system you should ensure you are aware of your responsibilities under the Data Protection
Act in respect of information/data stored or used in the system.
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Appendix C — New installation notice

During a new installation on a PC, the following notice is displayed to the user:
IMPORTANT NOTICE TO NEW USERS OF THE MOOREPAY DIRECT DEBIT SOLUTIONS SYSTEM

As you are a new user to the system, please carry out the following procedures to enable you to gain access
to the system and allow you to transmit.

If you have already carried out these procedures previously on this PC (or another PC if a network user)
please ignore this notice.

It is recommended that you print this notice (via the ‘print’ button below) before carrying out the
following procedures.
Accessing the System

On closing this notice you will be presented with the ‘Login Screen’. The cursor will be blinking at the
‘User ID’ entry field.

1. Enter the User ID, DDSETUP (then press TAB).
2. Enter the Password, DDTEST (then press TAB).
3. Click OK.

If the User ID and Password are valid, the Moorepay Direct Debit Solutions System is accessed.

Note:

The Moorepay Direct Debit Solutions System is installed with a default User ID and password as specified
above. The main purpose of this default user ID is to allow initial access to the system for the specific
purpose of setting up users to access the system. At least one of these users should have ‘supervisor’
access. Once a user with ‘supervisor’ access has been set up the ‘DDSETUP’ user will automatically be
deleted by the system. Please refer to the ‘User Maintenance’ section in the user guide for more details on
setting up new users within the system.

Test Transmission

If you intend to use a modem on this PC through the Moorepay Direct Debit Solutions System then certain
settings should be configured to allow you to transmit. To do this, please carry out the procedures detailed in
The role of the Supervisor (2) in section 4 relating to the transmission parameters in the System Setup
form. Once you have completed these procedures you should carry out a test transmission as detailed in
section 5.

If all details are configured correctly for your method of transmission the system should display a
Successful Test Transmission message. Click OK.
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Setting up Customer Numbers within the system.

Now that the modem has been successfully set up you have the option of setting up customer and
payer details within the system.

NB. for security reasons, you will not be able to import any details from the bureau unless a valid
‘transmission password’ has been allocated via the ‘Tools >System Setup’ screen.

The password allocated must match exactly the password set up for the customer within the
processing bureau. if they differ, or either passwords are not set up, the transmission will fail.

1. Select ‘Tools >Request Full Payer Setup’

2. Enter the Customer Number that you would like to set up within the PC System and click ‘OK’.

3. Click ‘Yes’ to the confirmation box. (The system will now send a request to the secure gateway.

You should now wait approximately 10-15 minutes until this request has been processed)

4. Select ‘File > Pickup files from bureau’ (If the request has been processed you will now be
prompted to import the payer details into your system).

5. Click 'OK’ to the ‘Import successfully completed.” information box.

Note:
If you are a network user and have other PCs using the system and accessing the same data, the details
need only be imported once, on the first PC. All other PCs should then be able to access the imported data.

Selecting your Customer Number.

All Customer Numbers set up in the system will be displayed via a drop-down box in the-top right corner
of the screen.
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Appendix D — Moorepay Direct Debit Solutions

Quick Reference

The table below sets out the different options to be found under each menu heading, with a few words
about what the option allows you to do. It also references the user access rights associated with the option
and the relevant section of the user guide for further information.

Menu Heading Activity Requireq User_ Gl
access rights section

File >

Test Transmission Send test transmission to Moorepay Supervisor/ 5.2
Direct Debit Solutions to ensure Transmit
correct functioning of modem

Temporarily disable “Locks” the system until the user Any user 11.1

current session re-keys their password

Exit Exits and shuts down the system Any user 11.2

Input >

Payer Details Set up, amend or cancel details of Input 6.2-6.3
payers and their bank accounts

Fixed Single Line Set up, amend or delete details of Input 7.1-73

Payments fixed payments

Variable Payments Set up, amend or delete details of Input 74-75
variable payments

Enquiry >

Current Payer Details Read-only access to details of Enquiry 8.1
current payers

Cancelled Payer Details | Read-only access to details of Enquiry 8.2
cancelled payers

Reports >

Payer Changes Report View and print changes processed by | Any 9.1
Moorepay Direct Debit Solutions

Bacs Debits Report View and print Bacs transactions Any 9.2
(latest or within specific date ranges)

Input Exceptions Report | View and print transactions containing | Any 9.3
rejected data, e.g. invalid sort codes

Current Changes Report | View and print details keyed but Any 9.4

not yet transmitted to Moorepay Direct
Debit Solutions
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Required User Guide

Menu Heading Activity

access rights section
Tools >
Transmit changes/ Transmit keyed input to Moorepay Transmit 10.1
Update details Direct Debit Solutions. Automatically
update payer information from bureau
records
Update details only Dial up Moorepay Direct Debit Import 10.2
Solutions to update payer information
from bureau records
Set up/Update Payers Dial up Moorepay Direct Debit Import 10.3
Solutions to set
up or update all payer records for a
specified Customer Number
Update Bank Account Dial up Moorepay Direct Debit Import 10.4
Check Files Solutions to obtain latest bank account
and sort code validation information
User Maintenance Control users’ access rights Supervisor 3
and passwords
System Setup Manage transmission settings for the Supervisor 4
system, including password, phone
number and modem details
Help Help and information about Moorepay | Any 1.4
Direct Debit Solutions
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